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BAB II 

LANDASAN TEORI 

2.1 Tinjauan Pustaka 

Sistem monitoring kecepatan dan jumlah kendaraan berbasis sensor dan 

mikrokontroler merupakan salah satu penerapan teknologi yang memiliki peran 

penting dalam meningkatkan keselamatan dan ketertiban lalu lintas, khususnya 

pada jalan lingkungan seperti gang permukiman. Sistem ini menawarkan solusi 

pemantauan yang lebih sederhana, murah, dan fleksibel dibandingkan sistem 

konvensional yang umumnya diterapkan pada jalan utama. Sebelum 

mengembangkan sistem ini lebih lanjut, diperlukan pemahaman terhadap 

penelitian-penelitian sebelumnya yang relevan sebagai landasan teori dan acuan 

pengembangan. Kajian ini bertujuan untuk mengetahui metode, teknologi, serta 

kekurangan dari penelitian terdahulu agar dapat dilakukan pengembangan sistem 

yang lebih optimal. 

1) Berdasarkan penelitian yang dilakukan oleh Ahmad Fauzi dan Rendy Pratama 

pada Jurnal Teknologi dan Sistem Komputer tahun 2021 dengan judul 

“Rancang Bangun Sistem Pengukur Kecepatan Kendaraan Menggunakan 

Sensor Infrared Berbasis Mikrokontroler”, dijelaskan bahwa pengukuran 

kecepatan kendaraan dapat dilakukan dengan memanfaatkan dua sensor 

infrared yang dipasang pada jarak tertentu. Kecepatan dihitung berdasarkan 

selisih waktu kendaraan melewati kedua sensor tersebut. Hasil penelitian 

menunjukkan bahwa sistem mampu mengukur kecepatan kendaraan dengan 

tingkat akurasi yang cukup baik. Namun, sistem yang dikembangkan belum 

dilengkapi dengan fitur penyimpanan data dan monitoring secara daring, 

sehingga data hasil pengukuran hanya dapat dilihat secara local[6]. 

2) Penelitian lain yang dilakukan oleh Darmawan, Sompie, dan Kambey pada 

Jurnal Teknik Elektro dan Komputer tahun 2020 dengan judul “Implementasi 

Internet of Things pada Monitoring Kecepatan Kendaraan Bermotor” 

menjelaskan penerapan teknologi IoT dalam sistem monitoring kecepatan 

kendaraan. Sistem ini menggunakan mikrokontroler yang terhubung ke jaringan 
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internet untuk mengirimkan data hasil pengukuran ke server secara real-time. 

Penelitian ini menunjukkan bahwa IoT sangat efektif digunakan untuk 

pemantauan lalu lintas. Namun, metode pengukuran kecepatan masih 

bergantung pada data GPS sehingga kurang optimal untuk jalan sempit atau 

gang dengan jarak pendek[7]. 

3) Berdasarkan penelitian yang dilakukan oleh Andi Setiawan dan Nanda Putra 

pada Jurnal Informatika dan Rekayasa Elektronika tahun 2020 dengan judul 

“Perancangan Sistem Deteksi Kendaraan Menggunakan Sensor Photo Beam”, 

sensor photo beam terbukti memiliki respons yang cepat dan akurasi yang baik 

dalam mendeteksi objek yang melintas. Sensor ini sangat sesuai digunakan pada 

area dengan ruang terbatas karena pemasangannya sederhana dan tidak 

mengganggu arus kendaraan. Akan tetapi, penelitian tersebut hanya difokuskan 

pada pendeteksian keberadaan kendaraan tanpa pengolahan data lanjutan 

seperti perhitungan kecepatan atau jumlah  kendaraan[8]. 

4) Penelitian yang dilakukan oleh Rizky Fenaldo Maulana et al. pada Indonesian 

Journal of Multidisciplinary on Social and Technology tahun 2022 dengan judul 

“Rancang Bangun Sistem Monitoring Berbasis IoT” menjelaskan bahwa 

monitoring data sensor dapat dilakukan melalui website secara real-time dengan 

memanfaatkan mikrokontroler dan jaringan internet. Sistem monitoring 

berbasis website memudahkan pengguna dalam mengakses data historis dan 

visualisasi pengukuran. Namun, sistem yang dikembangkan masih bersifat 

umum dan belum difokuskan pada aplikasi lalu lintas serta pengukuran 

kecepatan kendaraan secara spesifik[9]. 

Berdasarkan kajian terhadap penelitian-penelitian terdahulu, masih terdapat 

beberapa keterbatasan yang dapat dikembangkan lebih lanjut, antara lain belum 

terintegrasinya pengukuran kecepatan dan jumlah kendaraan dalam satu sistem, 

keterbatasan penerapan sistem pada jalan lingkungan atau jalan permukiman 

berskala lokal, serta belum optimalnya pemanfaatan sensor photo beam yang 

dipadukan dengan sistem monitoring berbasis website. Oleh karena itu, pada tugas 

akhir ini penulis mengembangkan sistem monitoring kecepatan dan jumlah 

kendaraan berbasis sensor photo beam dan ESP32 dengan monitoring melalui 
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website, sehingga sistem dapat digunakan sebagai sarana pengambilan data lalu 

lintas pada jalan lingkungan secara efektif dan real-time. 

2.2 Dasar Teori 

2.2.1 Sistem Monitoring Kecepatan Kendaraan 

Sistem monitoring kecepatan dan jumlah kendaraan merupakan suatu 

sistem yang digunakan untuk mengamati dan mencatat perilaku pergerakan 

kendaraan berdasarkan parameter kecepatan serta durasi kendaraan berada dalam 

kondisi diam pada suatu titik tertentu[10]. Sistem ini umumnya diterapkan untuk 

memperoleh data lalu lintas yang dapat digunakan sebagai bahan evaluasi 

keselamatan dan kelancaran arus kendaraan, khususnya pada jalan lingkungan atau 

jalan permukiman berskala lokal. 

Kecepatan kendaraan didefinisikan sebagai jarak tempuh kendaraan per 

satuan waktu, sedangkan jumlah kendaraan merupakan total kendaraan yang 

melewati titik pada jalan tertentu. Kendaraan yang melaju dengan kecepatan tinggi 

pada jalan lingkungan berpotensi menimbulkan gangguan lalu lintas dan 

meningkatkan risiko kecelakaan. 

Secara matematis, kecepatan kendaraan dapat dihitung menggunakan rumus dasar 

sebagai berikut: 

𝑣 =
𝑠

𝑡
 

Keterangan: 

• 𝑣= Kecepatan kendaraan (m/s atau Km/h) 

• 𝑠= Jarak tempuh kendaraan (meter) 

• 𝑡= Waktu tempuh kendaraan (detik) 

Pada sistem berbasis sensor photo beam, jarak 𝑠merupakan jarak tetap yang 

telah ditentukan antara dua titik sensor, sedangkan waktu 𝑡diperoleh dari selisih 

waktu antara saat kendaraan memutus sensor pertama hingga memutus sensor 

kedua. Dengan mengetahui kedua nilai tersebut, sistem dapat secara otomatis 

menghitung dan menampilkan nilai kecepatan kendaraan secara real-time. 

Pengukuran kedua parameter tersebut dapat dilakukan secara otomatis 

menggunakan sistem berbasis sensor dan mikrokontroler, sehingga data yang 
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diperoleh bersifat objektif dan berkesinambungan. Dengan adanya sistem 

monitoring, proses pencatatan data lalu lintas tidak lagi dilakukan secara manual, 

melainkan terintegrasi dan terdokumentasi secara digital. 

Dalam pengujian sistem berbasis sensor, suatu pengukuran dinyatakan valid 

apabila persentase error yang dihasilkan berada dalam batas toleransi yang telah 

ditetapkan. Penelitian mengenai sistem deteksi kecepatan kendaraan menetapkan 

bahwa sistem dinyatakan memiliki akurasi yang baik apabila nilai error berada di 

bawah 5%, atau dengan kata lain tingkat akurasi sistem mencapai di atas 95%. 

Berdasarkan acuan tersebut, pada penelitian ini ditetapkan bahwa data hasil 

pengukuran dinyatakan sesuai apabila persentase error berada pada rentang 0% 

hingga 5%, dan dinyatakan tidak sesuai apabila persentase error melebihi 5%[11]. 

2.2.2 Statistik Deskriptif 

Statistik deskriptif merupakan metode statistik yang digunakan untuk 

mengumpulkan, mengolah, menyajikan, dan menginterpretasikan data secara 

ringkas guna memberikan gambaran umum mengenai karakteristik suatu kumpulan 

data. Berbeda dengan statistik inferensial yang bertujuan untuk menarik kesimpulan 

terhadap populasi, statistik deskriptif hanya berfokus pada penggambaran data yang 

tersedia tanpa melakukan generalisasi lebih lanjut. 

Beberapa ukuran yang umum digunakan dalam statistik deskriptif antara 

lain nilai minimum, nilai maksimum, rata-rata (mean), dan standar deviasi. Nilai 

minimum dan maksimum menggambarkan rentang sebaran data, sedangkan rata-

rata menunjukkan nilai tengah dari keseluruhan data. Rata-rata dihitung 

menggunakan rumus sebagai berikut: 

𝑥̄ =
∑ 1𝑥𝑖𝑛
𝑖

𝑛
 

Keterangan: 

• 𝑥̄= Nilai rata-rata 

• 𝑥𝑖= Nilai data ke-𝑖 

• 𝑛= Jumlah data 

Standar deviasi merupakan ukuran yang menggambarkan seberapa besar 

variasi atau penyebaran data terhadap nilai rata-ratanya. Semakin besar nilai standar 



11 

 

 
 

deviasi, semakin besar variasi data yang terjadi. Rumus standar deviasi adalah 

sebagai berikut: 

𝜎√
∑ 1(𝑥𝑖 −𝑛
𝑖 𝑥̄)2

𝑛
 

Keterangan: 

• 𝜎= Standar deviasi 

• 𝑥𝑖= Nilai data ke-𝑖 

• 𝑥̄= Nilai rata-rata 

• 𝑛= Jumlah data 

Selain itu, dalam analisis data juga dikenal konsep outlier, yaitu data yang 

nilainya jauh menyimpang dari sebagian besar data lainnya. Salah satu metode 

identifikasi outlier yang umum digunakan adalah dengan menetapkan batas atas 

menggunakan rumus: 

𝑥𝑏𝑎𝑡𝑎𝑠 = 𝜇 + 2𝜎 

Keterangan: 

• 𝑥𝑏𝑎𝑡𝑎𝑠= Batas atas nilai normal 

• 𝜇= Nilai rata-rata 

• 𝜎= Standar deviasi 

Data yang melebihi nilai 𝑥𝑏𝑎𝑡𝑎𝑠dikategorikan sebagai outlier atau data yang 

berada di luar distribusi normal. Dalam konteks penelitian ini, metode statistik 

deskriptif digunakan untuk menganalisis karakteristik kecepatan kendaraan yang 

terdeteksi oleh sistem, meliputi nilai rata-rata, standar deviasi, serta identifikasi data 

outlier berdasarkan batas statistik yang telah ditetapkan. 

2.2.3 Sensor Infra Merah (Photo Beam) 

Sensor inframerah merupakan jenis sensor optik yang bekerja dengan 

memanfaatkan gelombang cahaya inframerah untuk mendeteksi keberadaan suatu 

objek. Salah satu implementasi sensor inframerah yang banyak digunakan adalah 

sensor photo beam, yang terdiri dari pemancar (transmitter) dan penerima 

(receiver). Sensor ini bekerja berdasarkan prinsip terputusnya berkas cahaya 

inframerah yang dipancarkan dari transmitter menuju receiver. Ketika sebuah objek 
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melintas dan menghalangi jalur cahaya tersebut, penerima akan mendeteksi 

perubahan intensitas cahaya sehingga menghasilkan perubahan sinyal sebagai 

indikasi keberadaan objek [12]. 

Sensor photo beam memiliki karakteristik respon yang cepat dan tingkat 

akurasi yang baik, sehingga sering digunakan pada sistem pendeteksian objek tanpa 

kontak langsung. Dalam sistem monitoring kendaraan, sensor photo beam 

dimanfaatkan untuk mencatat waktu saat kendaraan melintasi titik tertentu. Dengan 

menempatkan dua sensor photo beam pada jarak yang telah ditentukan, sistem 

dapat merekam waktu kendaraan melewati masing-masing sensor. Selisih waktu 

antar pembacaan sensor tersebut digunakan untuk menghitung kecepatan 

kendaraan, sedangkan lamanya sinar inframerah terputus pada satu titik dapat 

dianalisis untuk mengetahui jumlah kendaraan. 

 

Gambar 2. 1 Sensor Photo Beam 

Keunggulan penggunaan sensor inframerah jenis photo beam antara lain 

pemasangannya yang relatif sederhana, tidak memerlukan kontak fisik dengan 

kendaraan, serta mampu bekerja secara stabil pada area dengan ruang terbatas. Oleh 

karena itu, sensor ini dinilai sesuai dan efektif untuk diterapkan pada sistem 

monitoring kecepatan dan jumlah kendaraan pada skala lokal. 

2.2.4 Mikrokontroller 

Mikrokontroler merupakan sistem komputer terintegrasi dalam satu chip 

yang memiliki Central Processing Unit (CPU), memori, serta port input/output 

(I/O) yang digunakan untuk mengendalikan suatu sistem atau perangkat elektronik 
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secara spesifik [13]. Mikrokontroler dirancang untuk menjalankan tugas tertentu 

(special purpose computer) dengan konsumsi daya yang relatif rendah dan ukuran 

yang ringkas. Dalam satu chip mikrokontroler umumnya telah terintegrasi berbagai 

modul pendukung seperti RAM, ROM atau flash memory, timer, counter, 

komunikasi serial, serta modul analog seperti Analog to Digital Converter (ADC) 

dan Digital to Analog Converter (DAC). Pada sistem tertanam (embedded system), 

mikrokontroler berfungsi sebagai pengendali utama yang menerima input dari 

sensor, memproses data sesuai dengan program yang ditanamkan, kemudian 

menghasilkan output atau data informasi yang diperlukan. Kemampuan ini 

menjadikan mikrokontroler banyak digunakan pada sistem otomasi, sistem 

monitoring, serta aplikasi Internet of Things (IoT). 

 ESP32 merupakan salah satu jenis mikrokontroler pengembangan dari 

ESP8266 yang memiliki fitur lebih lengkap dan kinerja yang lebih tinggi. ESP32 

termasuk mikrokontroler berbasis system on chip (SoC) yang dikembangkan oleh 

Espressif Systems. Mikrokontroler ini dirancang untuk mendukung aplikasi 

Internet of Things (IoT) dengan menyediakan konektivitas WiFi dan Bluetooth 

dalam satu modul. ESP32 bekerja sebagai pengendali utama yang dapat membaca 

dan memproses data dari perangkat eksternal seperti sensor dan aktuator yang 

kemudian mengirimkan data tersebut ke jaringan menggunakan WiFi atau 

Bluetooth. ESP 32 memiliki beberapa mode seperti pada Tabel 2-1, salah satunya 

adalah operasi hemat daya yang dirancang untuk memperpanjang masa pakai 

baterai. Tabel 2-2 menunjukkan spesifikasi dan Gambar 2.2 menunjukkan deskripsi 

pin dan pinout pada ESP32. 

Tabel 2- 1 Mode Operasi ESP32 

Mode Deskripsi 

Active Mode Proses berjalan pada kecepatan penuh dan semua fitur aktif 

Modem Sleep  Wifi atau Bluetooth dinonaktifkan sementara prosesor tetap aktif 

untuk tugas-tugas tertentu 

Light Sleep Prosesor dimatikan sementara RAM tetap aktif 

Deep Sleep Hampir semua fungsi dimatikan kecuali RTC (Real Time Clock) 
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Tabel 2- 2 Spesifikasi ESP32 WROOM 32D 

Kategori Spesifikasi 

Proses Dual-core Xtensa® 32-bit LX6, hingga 240 MHz per core 

Memori 520 KB SRAM, hingga 16 MB Flash 

Konektivitas Wifi: IEEE 802.11 b/g/n (2.4 GHz) 

Bluetooth 4.2 (Classic & BLE) 

GPIO 34 Pin 

ADC 12-bit ADC, hingga 18 salura 

DAC 8-bit DAC (2 saluran) 

PWM Hingga 16 saluran PWM 

12C, SPI, UART Yes 

Tegangan Input 5V 

Tegangan Kerja 3.3V (operasi stabil antara 2.2V hingga 3.6V) 

Konsumsi Daya Active mode: ~160 Ma, Modem Sleep: ~30 mA, Light Sleep: 

~0,8 mA, Deep Sleep: <10 µA 

Ukuran Modul 18 x 25.5 mm 

Jumlah Pin 38 Pin 

WiFi Range Hingga 200 meter (tergantung kondisi lingkungan) 

Bluetooth Range Hingga 100 meter untuk BLE (tergantung daya transmisi) 

Lingkungan 

Kerja 

Suhu : -40°C hingga +125°C, Kelembapan: 5% hingga 95% 

(non-kondensasi) 

Sistem Operasi Mendukung FreeRTOS, Arduino IDE, Espressif IDF, 

PlatformIO 

Platform 

Pengembangan 

Arduino IDE, Espressif IoT Development Framework (IDF), 

PlatformIO 

 



15 

 

 
 

 

Gambar 2. 2 Pin Out ESP32 WROOM 32D 

Untuk menjalankan proses pengolahan data sesuai dengan fungsi yang 

dirancang, mikrokontroler ESP32 harus diprogram menggunakan serangkaian 

instruksi logika yang disimpan dalam memori internal. Instruksi tersebut ditulis 

menggunakan bahasa pemrograman tertentu, kemudian dikompilasi dan diunggah 

ke dalam mikrokontroler agar dapat dieksekusi sesuai dengan kebutuhan sistem. 

Salah satu perangkat lunak yang banyak digunakan dalam proses pemrograman 

ESP32 adalah Arduino Integrated Development Environment (Arduino IDE), yang 

menyediakan antarmuka serta pustaka pendukung untuk mempermudah penulisan, 

pengujian, dan pengunggahan program ke mikrokontroler. 

2.2.4.1 Arduino IDE 

Arduino IDE (Integrated Development Environment) merupakan sebuah 

perangkat lunak pengembangan yang digunakan untuk memfasilitasi proses 

pemrograman pada mikrokontroler berbasis platform Arduino. Perangkat lunak ini 

dirancang dengan tampilan antarmuka yang sederhana dan mudah dipahami, 

sehingga cocok digunakan dalam kegiatan pembelajaran maupun pengembangan 

sistem tertanam oleh pengguna dari berbagai tingkat keahlian. Melalui Arduino 
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IDE, pengguna dapat melakukan penulisan, pengeditan, kompilasi, serta 

pengunggahan program atau sketch ke papan mikrokontroler secara efektif. 

Bahasa pemrograman yang digunakan pada Arduino IDE mengacu pada 

bahasa C/C++ yang telah disederhanakan, sehingga proses penulisan kode menjadi 

lebih mudah dan terstruktur. Selain mendukung berbagai jenis papan 

mikrokontroler Arduino seperti Arduino Uno, Arduino Mega, dan Arduino Nano, 

Arduino IDE juga menyediakan kompatibilitas dengan mikrokontroler lain, 

termasuk ESP32. Dengan melakukan penambahan konfigurasi papan (board 

manager) dan pustaka yang diperlukan, ESP32 dapat diprogram secara langsung 

menggunakan Arduino IDE. Oleh karena itu, Arduino IDE dapat dimanfaatkan 

sebagai salah satu perangkat utama dalam pengembangan aplikasi berbasis ESP32, 

khususnya pada sistem monitoring dan otomasi berbasis mikrokontroler. 

 

Gambar 2. 3 Bagian-Bagian Arduino IDE 

Gambar 2.3 memperlihatkan tampilan awal saat aplikasi Arduino IDE 

dijalankan. Secara umum, Arduino IDE terdiri dari beberapa bagian utama yang 

saling mendukung proses pemrograman mikrokontroler. Bagian utama yang paling 

dominan adalah area kerja (workspace), yang digunakan sebagai tempat untuk 

menuliskan dan mengedit kode program (sketch) yang akan diunggah ke 

mikrokontroler. 

Pada bagian atas tampilan terdapat menu bar yang berisi menu File, Edit, 

Sketch, Tools, dan Help. Menu File digunakan untuk mengelola berkas program 
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seperti membuat, membuka, dan menyimpan sketch. Menu Edit berfungsi untuk 

melakukan pengolahan kode, seperti menyalin, memformat, serta memberikan 

komentar pada program. Menu Sketch digunakan untuk proses kompilasi, 

pengunggahan program ke mikrokontroler, serta penambahan pustaka yang 

dibutuhkan. Menu Tools berisi pengaturan teknis, antara lain pemilihan jenis papan 

mikrokontroler (board), pengaturan port komunikasi, serta akses ke fitur 

pemantauan serial. Sementara itu, menu Help menyediakan informasi bantuan, 

dokumentasi, dan referensi terkait penggunaan Arduino IDE. 

Selain menu bar, Arduino IDE juga dilengkapi dengan tool bar yang 

digunakan untuk berinteraksi secara langsung dengan mikrokontroler. Pada bagian 

ini tersedia tombol verifikasi program (verify) untuk memeriksa kesalahan kode 

sebelum proses pengunggahan, tombol upload untuk mengirimkan program ke 

papan mikrokontroler, serta informasi mengenai jenis papan dan port yang sedang 

digunakan. Arduino IDE juga menyediakan fitur Serial Monitor dan Serial Plotter. 

Serial Monitor digunakan untuk menampilkan data hasil komunikasi serial antara 

mikrokontroler dan komputer, sedangkan Serial Plotter berfungsi untuk 

memvisualisasikan data numerik dalam bentuk grafik. Fitur-fitur tersebut sangat 

membantu dalam proses pengujian, pemantauan, dan analisis data pada sistem yang 

dikembangkan. Untuk menggunakan Arduino IDE dapat melakukan Langkah-

langkah sebagai berikut. 

1. Membuka aplikasi Arduino IDE hingga muncul seperti tampilan pada Gambar 

2.3 

2. Menambahkan board ke Arduino IDE 

Untuk menambahkan jenis papan mikrokontroler yang tidak tersedia secara bawaan 

di Arduino IDE, pengguna dapat membuka menu File > Preferences seperti pada 

Gambar 2.4  
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Gambar 2. 4 Tampilan Menu File 

Pada jendela yang muncul, pengguna dapat memasukan tautan URL repositori 

board (seperti pada Gambar 2.5) pada kolom yang disediakan. Langkah ini 

bertujuan untuk memungkinkan Arduino IDE mengenali dan mendukung board 

tambahan seperti ESP32.  

 

Gambar 2. 5 URL Box untuk menambahkan board 

3. Menginstall board melalui board manager 

Setelah menambahkan URL repositori, pengguna perlu mengunduh dan menginstal 

jenis papan yang diinginkan melalui fitur Board Manager seperti  

pada Gambar 2.6. Akses dapat dilakukan melalui menu Tools > Board > Board 

Manager. Pada halaman yang tersedia, pengguna dapat mencari nama papan, 
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seperti “ESP32 by Espressif System”, kemudian menekan tombol Install untuk 

mengunduh dan menambahkan board tersebut kedalam Arduino IDE.  

 

Gambar 2. 6 Tampilan Board Manager 

4. Menginstal Library 

Untuk mengaktifkan berbagai fitur tambahan pada ESP32, pengguna juga perlu 

menambahkan pustaka pendukung. Proses ini dapat dilakukan melalui menu 

Tools > Manage Libraries atau Sketch > Include Library > Manage Libraries 

seperti pada Gambar 2.7. Melalui jendela Library Manager, pengguna dapat 

mencari dan menginstal 19ustaka yang sesuai dengan kebutuhan pemrograman. 

 

Gambar 2. 7 Tampilan Manage Library 
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5. Memilih jenis board dan port yang digunakan 

Sebelum memulai proses pemrograman, pengguna harus menentukan jenis 

board dan port komunikasi serial yang akan digunakan. Pemilihan jenis board 

dilakukan melalui menu Tools > Board seperti pada Gambar 2.8  

 

Gambar 2. 8 Tampilan Menu Tools untuk memilih Board 

Sedangkan port komunikasi dapat dipilih melalui Tools > Port  seperti pada Gambar 

2.9. Pengaturan ini penting agar Arduino IDE dapat terhubung secara tepat dengan 

perangkat keras yang digunakan.  

 

Gambar 2. 9 Tampilan Menu Tools untuk memilih Port 
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6. Menulis Program 

Setelah seluruh konfigurasi selesai, pengguna dapat mulai menulis program 

atau sketch pada area editor yang tersedia di Arduino IDE. Program ini berisi 

intruksi logika yang akan dijalankan oleh mikrokontroller. 

 

Gambar 2. 10 Area Sketch Pada Arduino IDE 

7. Menyimpan Program  

Setelah program selesai ditulis, selanjutnya menyimpan file program ke dalam 

folder pada perangkat computer. Proses penyimpanan dilakukan melalui menu 

File > Save As, di mana pengguna dapat menentukan lokasi penyimpanan dan 

nama file sesuai keinginan. Menu Save As dapat dilihat pada Gambar 2.11 

Program yang telah tersimpan dapat digunakan untuk proses verifikasi dan 

selanjutnya digunggah ke papan mikrokontroller agar dapat dijalankan. Untuk 

menentukan tempat penyimpanan file dapat dilihat pada Gambar 2.12 
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Gambar 2. 11 Tampilan Menu File untuk Save Project 

 

Gambar 2. 12 Tampilan Menu untuk meyimpan project di computer 

2.2.5 Real Time Clock (RTC) 

Real Time Clock (RTC) merupakan modul pewaktu yang berfungsi untuk 

menyimpan dan menjaga informasi waktu aktual seperti detik, menit, jam, hari, 

tanggal, bulan, dan tahun secara kontinu, meskipun sistem utama dalam kondisi 

mati atau mengalami pemutusan catu daya. RTC umumnya dilengkapi dengan 

sumber daya cadangan berupa baterai sehingga data waktu tetap tersimpan dengan 

akurat. Dalam sistem berbasis mikrokontroler, RTC digunakan untuk memberikan 

penanda waktu (timestamp) pada proses pembacaan sensor, pencatatan data, 

maupun pengendalian sistem secara terjadwal. Penggunaan RTC sangat penting 
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pada sistem monitoring dan otomasi yang membutuhkan ketepatan waktu secara 

real time, seperti sistem parkir cerdas, pencatatan data lingkungan, dan sistem 

keamanan, karena mampu meningkatkan keandalan serta konsistensi data yang 

dihasilkan [14]. 

Selain berfungsi sebagai pencatat waktu, modul RTC umumnya 

berkomunikasi dengan mikrokontroler melalui protokol komunikasi serial, seperti 

Inter-Integrated Circuit (I2C), sehingga memudahkan integrasi dengan sistem 

berbasis Arduino maupun ESP32. Dibandingkan dengan pewaktu internal 

mikrokontroler, RTC memiliki keunggulan dalam hal akurasi dan kontinuitas 

pencatatan waktu karena dilengkapi dengan osilator kristal dan sumber daya 

cadangan. Oleh karena itu, RTC lebih andal digunakan pada sistem yang 

membutuhkan pencatatan waktu jangka panjang dan tetap akurat meskipun terjadi 

pemadaman daya pada sistem utama. 

 

 

Gambar 2. 13 Rangkaian Real Time Clock DS3231 

Pada Gambar 2.13 ditunjukkan rangkaian Real Time Clock (RTC) DS3231 

yang digunakan sebagai pencatat dan penyedia informasi waktu secara real-time 

pada sistem. RTC DS3231 merupakan modul pencatat waktu dengan tingkat akurasi 

tinggi karena telah dilengkapi dengan kompensasi suhu internal, sehingga 

kesalahan waktu akibat perubahan suhu dapat diminimalkan. 

Prinsip kerja RTC DS3231 didasarkan pada osilator kristal internal yang 

menghasilkan pulsa clock stabil untuk menghitung satuan waktu, meliputi detik, 

menit, jam, tanggal, bulan, dan tahun. Data waktu tersebut disimpan dalam register 

internal dan dapat diakses oleh mikrokontroler melalui antarmuka komunikasi I2C 
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(Inter-Integrated Circuit) menggunakan dua jalur komunikasi, yaitu Serial Data 

(SDA) dan Serial Clock (SCL). 

Modul RTC DS3231 mendapatkan suplai tegangan utama sebesar 5V DC 

dari sistem catu daya, serta dilengkapi dengan baterai cadangan (backup battery) 

yang berfungsi untuk mempertahankan data waktu ketika catu daya utama terputus. 

Dengan adanya baterai cadangan ini, RTC tetap dapat bekerja secara mandiri tanpa 

kehilangan informasi waktu. 

Pada sistem yang dirancang, RTC DS3231 diintegrasikan dengan 

mikrokontroler sebagai referensi waktu untuk mendukung fungsi pencatatan data 

dan sinkronisasi sistem. Penggunaan RTC ini memungkinkan sistem tetap memiliki 

informasi waktu yang akurat dan stabil, sehingga sangat mendukung keandalan 

sistem secara keseluruhan. Skema rangkaian RTC ditunjukkan pada Gambar 2.14, 

sedangkan spesifikasi teknis RTC DS3231 disajikan pada Tabel 2-3 dan 2-4. 

Tabel 2- 3 Deskripsi Pin RTC 

Pin Deskripsi 

32K Output sinyal clock 32,7 kHz 

SQW Output Square Wave/Interrupt 

SCL Jalur Clock Komunikasi I2C 

SDA Jalur Data Komunikasi I2C 

VCC Tegangan catu daya utama (3,3V – 5V) 

GND Ground Sistem 

 

Tabel 2- 4 Spesifikasi RTC DS3231 

Parameter Spesifikasi 

Tipe Real Time Clock (RTC) 

Model DS3231 

Komunikasi Antarmuka I2C 

Tegangan Operasi 3,3V – 5V 

Tegangan Baterai (Vbat) 2,3V – 5V 

Konsumsi Arus 200 µA 
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Format Waktu Jam, Menit, Detik 

Format Kalender Tanggal, Hari, Bulan, Tahun 

Output Clock  32,7 kHz 

Square Wave Output 1 Hz, 1,024 kHz, 4,096 kHz, 8,192 kHz 

Suhu Operasi −40 °C hingga +85 °C 

Media Backup Baterai Koin (CR2032) 

Fungsi Utama Penjaga Waktu dan tanggal presisi tinggi 

 

Gambar 2. 14 Bentuk Fisik dan Simbol Real Time Clock DS3231 

2.2.6 Buzzer  

Buzzer merupakan komponen elektronika yang berfungsi sebagai perangkat 

keluaran (output device) untuk menghasilkan sinyal bunyi sebagai indikator atau 

peringatan dalam suatu sistem. Buzzer bekerja dengan mengubah energi listrik 

menjadi energi bunyi melalui getaran mekanis yang dihasilkan oleh elemen 

piezoelektrik atau kumparan elektromagnetik. Ketika buzzer diberikan tegangan 

atau sinyal listrik tertentu, elemen internalnya akan bergetar sehingga menghasilkan 

suara dengan frekuensi dan intensitas tertentu yang dapat didengar oleh manusia 

[15]. 

Prinsip kerja buzzer didasarkan pada proses osilasi atau getaran yang terjadi 

akibat pemberian sinyal listrik. Pada buzzer jenis piezoelektrik, getaran dihasilkan 

oleh perubahan bentuk material piezoelektrik ketika dialiri tegangan, sedangkan 

pada buzzer elektromagnetik getaran dihasilkan oleh gaya tarik kumparan terhadap 
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membran. Getaran tersebut menghasilkan gelombang suara yang berfungsi sebagai 

tanda atau notifikasi terhadap kondisi tertentu dalam sistem. 

Dalam sistem berbasis mikrokontroler, buzzer digunakan sebagai indikator 

audio untuk memberikan informasi kepada pengguna, seperti tanda peringatan, 

konfirmasi, maupun alarm. Buzzer umumnya diaktifkan melalui pin digital 

mikrokontroler, baik secara langsung maupun melalui rangkaian driver tambahan, 

tergantung pada kebutuhan arus dan tegangan. Penggunaan buzzer memungkinkan 

sistem memberikan respon yang cepat dan mudah dikenali tanpa memerlukan 

tampilan visual.Berdasarkan cara pengoperasiannya, buzzer dapat diklasifikasikan 

menjadi buzzer aktif dan buzzer pasif. Buzzer aktif dapat menghasilkan bunyi 

secara langsung ketika diberi tegangan, sedangkan buzzer pasif memerlukan sinyal 

gelombang tertentu dari mikrokontroler untuk menghasilkan suara. Buzzer aktif 

lebih banyak digunakan karena memiliki rangkaian yang sederhana dan mudah 

diintegrasikan dengan sistem digital. 

Pada penelitian ini, buzzer digunakan sebagai indikator peringatan pada 

sistem berbasis mikrokontroler ESP32 untuk memberikan informasi audio terkait 

kondisi tertentu yang terjadi pada sistem. Dengan penggunaan buzzer, sistem 

menjadi lebih interaktif dan mampu memberikan notifikasi secara langsung kepada 

pengguna.  

Pada Gambar 2.15 ditunjukkan modul buzzer yang digunakan sebagai 

perangkat keluaran audio pada sistem. Buzzer berfungsi sebagai indikator bunyi 

untuk memberikan informasi atau peringatan terhadap kondisi tertentu yang terjadi 

pada sistem. Suara yang dihasilkan oleh buzzer digunakan sebagai bentuk notifikasi 

langsung kepada pengguna tanpa memerlukan tampilan visual. 

Prinsip kerja buzzer didasarkan pada konversi energi listrik menjadi energi 

bunyi melalui getaran elemen internal, seperti elemen piezoelektrik atau 

elektromagnetik. Ketika buzzer menerima sinyal listrik dari mikrokontroler, elemen 

tersebut akan bergetar dan menghasilkan gelombang suara dengan frekuensi 

tertentu yang dapat didengar oleh pengguna. 

Dalam sistem berbasis mikrokontroler, buzzer umumnya dikendalikan 

melalui sinyal digital untuk mengatur kondisi aktif atau tidak aktifnya buzzer sesuai 
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dengan kebutuhan sistem. Pola bunyi yang dihasilkan dapat disesuaikan dengan 

logika pemrograman sehingga buzzer dapat digunakan sebagai penanda atau 

peringatan terhadap kejadian tertentu. 

Pada sistem yang dirancang, buzzer diintegrasikan dengan mikrokontroler 

sebagai media notifikasi audio untuk mendukung interaksi antara sistem dan 

pengguna. Penggunaan buzzer ini memungkinkan sistem memberikan peringatan 

secara cepat dan efektif, sehingga meningkatkan kejelasan informasi dan keandalan 

sistem secara keseluruhan, sedangkan spesifikasi teknis buzzer disajikan pada table 

2-5 dan 2-6. 

Tabel 2- 5 Deskripsi Pin Buzzer 

Pin Deskripsi 

GND Ground Sistem 

VCC Tegangan catu daya 3,3V – 5V 

SIG/I/O Pin Kontrol Buzzer (input sinyal digital) 

 

Tabel 2- 6 Spesifikasi Buzzer 

Spesifikasi Parameter 

Tipe Buzzer Aktif 

Model KY-012 

Tegangan Operasi 3,3V- 5V 

Arus Kerja 20Ma 

Metode Kontrol Sinyal Digital High/Low 

Frekuensi Bunyi 2 kHz 

Antarmuka Digital 

Jumlah Pin 3 Pin 

Indikator Bunyi 

Fungsi Utama Alarm, notifikasi, peringatan 
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Gambar 2. 15 Bentuk Fisik dan Simbol Buzzer KY-012 

2.2.7 Step Down 

Modul step-down DC-DC 3A 10W merupakan rangkaian regulator 

switching tipe buck converter yang berfungsi menurunkan tegangan DC menjadi 

tegangan DC yang lebih rendah dengan efisiensi tinggi. Modul ini tersedia dalam 

beberapa varian tegangan keluaran tetap (fixed output) yaitu 3,3V, 5V, 9V, dan 12V. 

Pada sistem yang dirancang, digunakan varian 5V sebagai sumber tegangan stabil 

untuk rangkaian pendukung seperti buzzer dan bagian input regulator 3,3V untuk 

ESP32. 

Prinsip kerja buck converter didasarkan pada teknik switching 

menggunakan transistor berkecepatan tinggi yang dikombinasikan dengan induktor, 

dioda, dan kapasitor filter. Proses switching ini menghasilkan tegangan keluaran 

yang lebih rendah dari tegangan masukan dengan efisiensi yang tinggi, sehingga 

daya yang hilang dalam bentuk panas relatif kecil dibandingkan regulator linier. 

Penggunaan konverter DC-DC tipe buck banyak diterapkan pada sistem 

embedded dan perangkat IoT karena memiliki efisiensi tinggi serta kemampuan 

menjaga kestabilan tegangan terhadap perubahan beban. Menurut Zhang et al. 

(2019) dalam IEEE Access, konverter buck banyak digunakan pada aplikasi 

tegangan rendah karena memiliki efisiensi tinggi dan performa regulasi tegangan 

yang baik terhadap variasi input maupun beban[16]. Pada sistem monitoring 

kecepatan kendaraan berbasis ESP32 yang dirancang, modul step-down 5V 

digunakan untuk memastikan suplai tegangan tetap stabil, sehingga mencegah 

terjadinya gangguan sistem akibat fluktuasi tegangan sumber utama. sedangkan 

spesifikasi teknis Modul Step Down disajikan pada table 2-7 dan 2-8. 
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Tabel 2- 7 Deskripsi Pin Modul Step Down 

Pin Deskripsi 

IN+ Terminal input positif dari sumber tegangan DC 

IN- Terminal ground sumber tegangan 

OUT+ Terminal output positif 

OUT- Terminal ground keluaran 

 

Tabel 2- 8 Spesifikasi Modul Step Down 

Spesifikasi Parameter 

Tipe Konverter Buck Converter 

Tegangan Input 6V – 24V DC (Tergantung Modul) 

Tegangan Output 5V DC 

Arus Maksimum 3A 

Daya Maksimum 10W 

 

 

Gambar 2. 16 Modul Step Down 

2.2.8 LCD I2C 16x2 

LCD I2C merupakan modul tampilan berbasis Liquid Crystal Display 

(LCD) yang menggunakan protokol komunikasi Inter-Integrated Circuit (I2C) 

untuk berkomunikasi dengan mikrokontroler. Pada sistem yang dirancang, modul 

LCD I2C diintegrasikan dengan mikrokontroler ESP32 sebagai media penampil 

informasi sistem. 

Antarmuka I2C memungkinkan komunikasi hanya menggunakan dua jalur 

data utama, yaitu SDA (Serial Data) dan SCL (Serial Clock), sehingga lebih efisien 

dalam penggunaan pin dibandingkan metode paralel konvensional. Pada ESP32, 
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pin I2C dapat dikonfigurasi secara fleksibel melalui pemrograman, namun secara 

umum menggunakan GPIO21 sebagai SDA dan GPIO22 sebagai SCL. 

LCD 16x2 digunakan sebagai media interaksi pengguna (user interface) yang 

menampilkan informasi sistem secara real-time, seperti: 

a. Status sensor (aktif/tidak aktif) 

b. Proses monitoring atau scanning (berjalan/selesai) 

c. Nilai kecepatan kendaraan yang terdeteksi 

d. Konfirmasi pencatatan atau penyimpanan data 

Penggunaan LCD I2C pada sistem berbasis ESP32 memberikan beberapa 

keuntungan, antara lain: 

• Menghemat jumlah pin GPIO 

• Mempermudah proses wiring 

• Mendukung komunikasi data yang stabil 

• Memudahkan proses debugging tanpa memerlukan koneksi komputer 

Modul LCD I2C umumnya menggunakan IC ekspander seperti PCF8574 yang 

mengubah komunikasi I2C menjadi sinyal paralel untuk LCD. Dengan demikian, 

ESP32 dapat mengontrol tampilan hanya melalui dua jalur komunikasi. 

Pada sistem monitoring kecepatan kendaraan yang dirancang, LCD 16x2 

berfungsi sebagai indikator visual untuk menampilkan hasil pembacaan sensor 

photo beam dan status sistem secara langsung kepada pengguna. Gambar LCD I2C 

dan Pinout dapat dilihat pada gambar 2.17 dan tabel 2-9. 

Tabel 2- 9 Deskripsi Pin Modul LCD I2C 

Pin Deskripsi 

GND Ground – dihubungkan ke GND pada mikrokontroler. 

VCC Tegangan input – dihubungkan ke 5V (beberapa modul 

kompatibel juga dengan 3.3V). 

SDA Jalur data I2C (terhubung ke GPIO ESP32) 

SCL Jalur data I2C (terhubung ke GPIO ESP32) 
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Gambar 2. 17 Gambar dan Pinout LCD I2C 

2.2.9 Baterai VRLA 12V 7Ah 

Baterai merupakan perangkat elektrokimia yang berfungsi untuk 

menyimpan energi listrik dalam bentuk energi kimia dan melepaskannya kembali 

dalam bentuk energi listrik saat dibutuhkan oleh sistem. Pada penelitian ini, 

digunakan baterai jenis Valve Regulated Lead Acid  atau yang sering dikenal sebagai 

baterai kering (Sealed Lead Acid). 

Baterai VRLA memiliki keunggulan utama berupa sifatnya yang bebas 

perawatan di mana pengguna tidak perlu melakukan pengisian ulang air aki secara 

berkala karena sistem katup pengamannya mampu melakukan rekombinasi gas 

oksigen dan hidrogen kembali menjadi air di dalam sel baterai[17]. Spesifikasi 

tegangan nominal 12 Volt dan kapasitas 7Ah menunjukkan bahwa secara teoretis 

baterai ini mampu menyuplai arus sebesar 7 Ampere selama satu jam, atau arus 

yang lebih kecil dalam durasi yang lebih lama misalnya 0,35 Ampere selama 20 

jam sesuai standar discharge rate. 

Dalam sistem monitoring kecepatan ini, baterai berfungsi sebagai jantung 

penyimpanan energi. Keberadaan baterai menjamin reliabilitas sistem agar tetap 

dapat beroperasi secara kontinu selama 24 jam, mengompensasi fluktuasi energi 

yang dihasilkan oleh panel surya akibat perubahan cuaca, serta menyediakan arus 

instan yang stabil bagi mikrokontroler ESP32 dan sensor photo beam saat 

melakukan proses deteksi dan transmisi data ke spreadsheet. 
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2.2.10 Solar Charge Control 

Solar Charge Controller (SCC) merupakan perangkat elektronika daya 

yang berfungsi sebagai regulator tegangan dan arus yang mengalir dari panel surya 

menuju baterai, sekaligus mengontrol distribusi daya ke beban. Unit yang 

digunakan dalam sistem ini adalah SCC tipe Pulse Width Modulation (PWM) 

dengan kapasitas arus maksimal sebesar 10 Ampere. 

Prinsip kerja SCC tipe PWM adalah dengan melakukan pensaklaran 

frekuensi tinggi untuk menyesuaikan tegangan panel surya dengan tegangan 

baterai. Saat baterai mendekati kapasitas penuh, SCC akan mempersempit lebar 

pulsa arus (duty cycle) guna mencegah terjadinya overcharging yang dapat 

menyebabkan overheating dan penguapan elektrolit. Selain itu, SCC ini dilengkapi 

dengan fitur Low Voltage Disconnect (LVD) yang secara otomatis akan memutus 

aliran listrik ke beban jika tegangan baterai turun di bawah ambang batas aman 

umumnya 10.8V - 11.1V, sehingga baterai terlindungi dari kondisi deep discharge 

yang dapat memperpendek usia pakai[18]. 

Pemilihan kapasitas 10A pada SCC ini memberikan faktor yang sangat baik 

bagi sistem, mengingat arus maksimal yang dihasilkan oleh panel surya 20 Wp 

hanya berkisar antara 1.1 hingga 1.2 Ampere. Dengan kapasitas yang lebih besar 

dari kebutuhan beban, SCC dapat bekerja dengan suhu yang lebih rendah dan 

memiliki durabilitas yang lebih tinggi dalam pengoperasian jangka panjang di 

lapangan. 

2.2.11 Power Supply 

Power supply adaptor switching 12V 3A merupakan perangkat catu daya 

yang digunakan untuk menyediakan tegangan searah sebesar 12 Volt dengan 

kapasitas arus hingga 3 Ampere guna memenuhi kebutuhan daya pada sistem yang 

dirancang. Perangkat ini termasuk ke dalam jenis Switch-Mode Power Supply yang 

bekerja dengan prinsip pensaklaran frekuensi tinggi, sehingga mampu 

menghasilkan ukuran yang lebih ringkas dan efisiensi daya yang lebih tinggi 

dibandingkan catu daya linier konvensional[20]. 

Prinsip kerja power supply switching diawali dengan penyearahan tegangan 

bolak-balik dari sumber listrik PLN menjadi tegangan searah, yang kemudian 
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diolah melalui rangkaian pensaklaran frekuensi tinggi. Tegangan tersebut diproses 

oleh komponen transformator switching untuk diturunkan ke level 12V DC dan 

distabilkan melalui rangkaian penyaring agar diperoleh tegangan yang konstan serta 

aman bagi beban elektronik. 

Pada sistem monitoring ini, power supply adaptor switching 12V 3A 

digunakan sebagai sumber daya utama pada unit pemancar (transmitter). 

Penggunaan adaptor ini memastikan sensor pemancar memperoleh suplai daya 

yang stabil secara kontinu dari jaringan PLN, sehingga proses pemancaran sinar 

inframerah tetap optimal. Spesifikasi lengkap dari catu daya yang digunakan 

ditampilkan pada Tabel 2-10, sedangkan Gambar 2.18 memperlihatkan bentuk fisik 

dari adaptor serta simbol yang digunakan dalam wiring diagram. 

Tabel 2- 10 Spesifikasi Power Supply Yang Digunakan 

Parameter Spesifikasi 

Tegangan Output 12V DC 

Arus Maksimum 3A 

Daya Maksimum 36W 

Tipe Power Supply Switch Mode Power Supply 

Tegangan Input 100V-265V 50/60Hz 

Fungsi Pada 

Sistem 

Menyediakan catu daya 12V DC untuk rangkaian sistem 

 

 

Gambar 2. 18 Bentuk Fisik Power Supply 
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2.2.12 Panel Surya (PLTS) 

Panel surya (solar panel) merupakan perangkat yang digunakan untuk 

mengubah energi cahaya matahari menjadi energi listrik dalam bentuk arus searah 

(DC) melalui efek fotovoltaik. Panel surya tersusun dari beberapa sel surya 

berbahan semikonduktor, umumnya silikon, yang mampu menghasilkan tegangan 

listrik ketika terkena radiasi cahaya matahari. Energi listrik yang dihasilkan panel 

surya dimanfaatkan sebagai sumber daya alternatif yang ramah lingkungan dan 

berkelanjutan[17]. 

Prinsip kerja panel surya didasarkan pada efek fotovoltaik, yaitu fenomena 

ketika foton cahaya matahari mengenai permukaan sel surya dan menyebabkan 

elektron bergerak dari pita valensi ke pita konduksi. Pergerakan elektron ini 

menghasilkan arus listrik DC pada terminal keluaran panel surya. Tegangan dan 

arus yang dihasilkan bergantung pada intensitas cahaya matahari, luas permukaan 

panel, serta karakteristik material sel surya yang digunakan. 

Panel surya banyak digunakan pada berbagai aplikasi sistem elektronika dan 

kelistrikan, seperti sistem penerangan, pembangkit listrik tenaga surya skala kecil, 

sistem monitoring, serta perangkat berbasis mikrokontroler. Penggunaan panel 

surya memungkinkan sistem untuk beroperasi secara mandiri tanpa ketergantungan 

penuh pada sumber listrik konvensional, sekaligus mendukung pemanfaatan energi 

terbarukan. 

Pada sistem yang dirancang, panel surya digunakan sebagai salah satu 

sumber catu daya untuk menyuplai energi listrik pada bagian tertentu dari sistem. 

Energi listrik yang dihasilkan panel surya kemudian diatur dan disesuaikan melalui 

rangkaian pendukung agar dapat digunakan secara aman dan stabil oleh beban. 

Pemanfaatan panel surya pada sistem ini diharapkan dapat meningkatkan efisiensi 

energi serta mendukung konsep sistem yang ramah lingkungan dan berkelanjutan. 

Bentuk fisik panel surya ditunjukkan pada Gambar 2.19, sedangkan spesifikasi 

teknis panel surya yang digunakan disajikan pada Tabel 2-11. 
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Tabel 2- 11 Spesifikasi Panel Surya Yang Digunakan 

Parameter Spesifikasi 

Jenis Panel Monocrystalline 

Merek Mitsuyama 

Daya Maksimum 20Wp 

Tegangan Daya Maksimum 18V 

Arus Daya Maksimum 1,11A 

Fungsi Pada Sistem Sistem PLTS kecil, sistem monitoring, sensor, 

dan perangkat berbasis mikrokontroller 

 

 

Gambar 2. 19 Bentuk Fisik Panel Surya 

2.2.13 Sistem Catu Daya 

Sistem catu daya pada penelitian ini dirancang secara komprehensif untuk 

menyediakan suplai energi listrik yang stabil dan berkelanjutan bagi seluruh 

komponen sistem terintegrasi. Mengingat perangkat monitoring ini terdiri dari dua 

unit yang terpisah secara fisik, yaitu unit penerima (receiver) dan unit pemancar 

(transmitter), maka rancangan sistem catu daya dibagi menjadi dua metode 

penyediaan energi yang berbeda guna menyesuaikan dengan karakteristik 

operasional masing-masing unit.  

Pada unit penerima yang berfungsi sebagai pusat pengolahan data, sistem 

menggunakan skema mandiri tenaga surya Off Grid Solar System. Sumber energi 

utama berasal dari panel surya monocrystalline dengan kapasitas 20 Wp yang 

bertugas mengonversi energi matahari menjadi listrik arus searah. Aliran energi ini 

diatur secara cerdas oleh Solar Charge Controller yang berfungsi mengoptimalkan 
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proses pengisian daya ke dalam baterai 12V 7Ah serta mencegah terjadinya 

pengisian berlebih maupun pengosongan berlebih. Keberadaan baterai sebagai 

media penyimpanan energi menjadi komponen krusial yang menjamin sistem tetap 

dapat beroperasi secara kontinu selama 24 jam, termasuk pada malam hari atau saat 

intensitas cahaya matahari rendah. Untuk memenuhi kebutuhan tegangan 

operasional mikrokontroler ESP32 yang bekerja pada level 5V, sistem dilengkapi 

dengan modul stepdown yang berfungsi menurunkan tegangan dari baterai secara 

efisien dan stabil[20]. 

Sementara itu, unit pemancar dirancang untuk menggunakan sumber daya 

dari jaringan listrik PLN 220V AC yang tersedia di lokasi penelitian. Pendekatan 

ini dipilih untuk menyederhanakan instalasi pada sisi pemancar yang membutuhkan 

suplai daya kontinu tanpa jeda. Tegangan bolak-balik dari PLN dikonversi menjadi 

tegangan searah melalui Power Supply Unit dengan keluaran 12V 3A. Tegangan 

DC yang stabil ini disuplai secara langsung ke sensor pemancar (transmitter photo 

beam) untuk memastikan sinar inframerah dapat dipancarkan dengan kuat dan 

konsisten menuju unit penerima.  

Secara keseluruhan, integrasi antara sistem tenaga surya mandiri pada unit 

penerima dan suplai listrik PLN pada unit pemancar menciptakan sinergi yang 

mengoptimalkan reliabilitas sistem monitoring. Penggunaan baterai dan SCC pada 

unit pusat data memastikan bahwa proses perekaman dan pengiriman data 

kecepatan kendaraan ke spreadsheet tetap berjalan meskipun terjadi fluktuasi 

cuaca, sehingga sistem memiliki ketahanan operasional yang tinggi dalam 

mendukung pengumpulan data lalu lintas secara real-time. 

2.2.14 Website Monitoring 

Website merupakan sekumpulan halaman yang saling terhubung dalam 

suatu jaringan dan dapat diakses melalui internet menggunakan protokol HTTP 

maupun HTTPS. Pada sistem monitoring, website berperan sebagai media 

antarmuka pengguna (user interface) yang memungkinkan pengguna untuk melihat 

serta berinteraksi dengan data yang ditampilkan secara real-time. Melalui website, 

informasi yang diperoleh dari sistem dapat dipantau dengan mudah dari berbagai 

perangkat selama terhubung ke jaringan internet. 
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Dalam pengembangan sistem monitoring berbasis website ini digunakan 

beberapa bahasa pemrograman web, yaitu HTML, CSS, JavaScript, dan PHP. 

Keempat bahasa tersebut saling melengkapi dalam membangun tampilan yang 

informatif, interaktif, serta mampu menangani proses pertukaran data antara 

pengguna dan server. Proses pembuatan website dilakukan menggunakan aplikasi 

Visual Studio Code (VS Code), yang merupakan editor kode modern dengan 

berbagai fitur pendukung seperti penulisan program, pengujian, serta debugging. 

1. HTML (HyperText Markup Language) digunakan sebagai dasar dalam 

penyusunan struktur halaman web. HTML berfungsi untuk mengatur susunan 

elemen-elemen utama seperti judul, teks, tabel, gambar, tombol, dan formulir. 

Pada sistem monitoring ini, HTML dimanfaatkan untuk membangun tampilan 

dashboard serta menampilkan data hasil pemantauan dalam bentuk tabel. Selain 

itu, elemen formulir seperti <form>, <input>, dan <button> digunakan untuk 

menerima masukan dari pengguna apabila diperlukan. 

2. CSS (Cascading Style Sheets) berfungsi untuk mengatur tampilan visual 

halaman agar lebih menarik dan mudah dipahami. Pengaturan yang dilakukan 

meliputi warna latar belakang, ukuran dan jenis huruf, jarak antar elemen, posisi 

objek, serta tata letak keseluruhan halaman. Dengan penggunaan CSS, tampilan 

dashboard menjadi lebih rapi dan nyaman digunakan. Selain itu, teknik 

responsive design juga diterapkan agar halaman website dapat menyesuaikan 

dengan berbagai ukuran layar, baik pada komputer maupun perangkat seluler. 

3. JavaScript merupakan bahasa pemrograman yang berjalan di sisi klien dan 

digunakan untuk menambahkan fungsi interaktif pada halaman web. Dalam 

sistem monitoring ini, JavaScript berperan dalam memproses interaksi 

pengguna, melakukan validasi input, serta memperbarui tampilan data secara 

dinamis tanpa harus memuat ulang halaman. Proses pembaruan data dapat 

dilakukan menggunakan teknik AJAX sehingga informasi monitoring dapat 

ditampilkan secara real-time. 

4. PHP (Hypertext Preprocessor) merupakan bahasa pemrograman yang berjalan 

di sisi server dan digunakan untuk memproses logika program serta 

menghubungkan website dengan basis data. PHP berfungsi untuk menerima 
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data dari pengguna maupun perangkat, menyimpan data ke dalam database 

MySQL, serta mengambil kembali data tersebut untuk ditampilkan pada 

halaman web. Selain itu, PHP juga mengatur berbagai proses backend sehingga 

sistem dapat berjalan secara terstruktur dan aman. 

Dalam proses pengembangan website, setiap berkas program disimpan 

dengan ekstensi sesuai bahasa yang digunakan agar dapat dikenali dengan baik oleh 

editor maupun server. Sebagai contoh, berkas dashboard.html digunakan untuk 

struktur halaman, style_dashboard.css untuk pengaturan tampilan, proses.js untuk 

fungsi interaktif, dan export_data.php untuk pengolahan data di sisi server. 

Penyesuaian penamaan berkas ini penting untuk menjaga kerapian proyek serta 

memudahkan proses pengembangan dan pemeliharaan sistem. 

 

Gambar 2. 20 Format Penyimpanan File Kode Sesuai Bahasa Yang Digunakan 

Untuk mulai membuat website menggunakan VS Code dapat melakukan langkah-

langkah sebagai berikut. 

1. Buka Visual Studio Code sehingga akan menunjukkan tampilan awal seperti 

pada Gambar 2.21. 

 

Gambar 2. 21 Tampilan Awal Visual Studio Code 
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2. Pilih menu New File dan pilih Text File seperti pada Gambar 2.22 

 

Gambar 2. 22 Menu Text File Untuk Memulai Pemrograman 

3. Setelah memilih menu Text File, pengguna akan diarahkan ke workspace 

utama seperti pada Gambar 2.23 yang siap digunakan untuk pemrograman. 

 

Gambar 2. 23 Workspace Utama Visual Studio Code 

2.2.15 Visual Studio Code 

Visual Studio Code (VS Code) merupakan sebuah perangkat lunak editor 

kode sumber (source-code editor) yang dikembangkan oleh Microsoft dan dapat 

digunakan secara gratis pada berbagai sistem operasi seperti Windows, macOS, dan 

Linux. VS Code banyak digunakan oleh pengembang perangkat lunak karena 
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memiliki ukuran yang ringan, tampilan yang sederhana, serta mendukung berbagai 

bahasa pemrograman modern. 

Dalam perancangan sistem pada proyek ini, VS Code digunakan sebagai 

lingkungan pengembangan utama untuk menulis dan mengelola kode program pada 

website monitoring. Bahasa pemrograman yang digunakan meliputi HTML, CSS, 

JavaScript, dan PHP yang berfungsi untuk membangun tampilan antarmuka serta 

logika sistem pada sisi server maupun klien. Dengan menggunakan VS Code, 

proses penulisan kode dapat dilakukan secara lebih terstruktur dan efisien. Salah 

satu keunggulan VS Code adalah dukungan terhadap berbagai ekstensi yang dapat 

disesuaikan dengan kebutuhan pengembangan. Ekstensi tersebut membantu dalam 

mempercepat proses penulisan kode melalui fitur seperti auto-complete, syntax 

highlighting, serta pendeteksian kesalahan secara otomatis. Selain itu, VS Code 

juga menyediakan fitur debugging dan live preview yang memudahkan 

pengembang dalam melakukan pengujian tampilan website secara langsung melalui 

browser. 

Penggunaan VS Code juga mempermudah pengelolaan berkas proyek 

karena seluruh file program dapat diorganisasi dalam satu workspace. Hal ini sangat 

membantu dalam proses pengembangan sistem monitoring yang terdiri dari 

beberapa berkas dengan bahasa pemrograman yang berbeda.  

Berdasarkan berbagai keunggulan tersebut, Visual Studio Code dipilih 

sebagai alat utama dalam proses pengembangan sistem karena mampu memberikan 

kemudahan, efisiensi, serta kenyamanan dalam penulisan dan pengelolaan kode 

program. 
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